Part No. 315893-C Rev 00
May 2004

4655 Great America Parkway
Santa Clara, CA 95054

Using the 10 Gigabit Ethernet
Modules: 8681XLR and
8681XLW

Passport 8000 Series Software Release 3.7

VNREEFACUE AT AR MR N Q RTEL
NETWORKS



Copyright © 2004 Nortel Networks

All rights reserved. May 2004.

Theinformation in this document is subject to change without notice. The statements, configurations, technical data, and
recommendations in this document are believed to be accurate and reliable, but are presented without express or implied
warranty. Users must take full responsibility for their applications of any products specified in this document. The
information in this document is proprietary to Nortel Networks Inc.

The software described in this document is furnished under alicense agreement and may be used only in accordance
with the terms of that license. The software license agreement is included in this document.

Trademarks

Nortel Networks, the Nortel Networks logo, the Globemark, Unified Networks, and PASSPORT are trademarks of
Nortel Networks.

Adobe and Acrobat Reader are trademarks of Adobe Systems Incorporated.
Microsoft, Windows, and Windows NT are trademarks of Microsoft Corporation.
The asterisk after a name denotes a trademarked item.

Restricted rights legend

Use, duplication, or disclosure by the United States Government is subject to restrictions as set forth in subparagraph
(c)(1)(ii) of the Rightsin Technical Data and Computer Software clause at DFARS 252.227-7013.

Notwithstanding any other license agreement that may pertain to, or accompany the delivery of, this computer software,
the rights of the United States Government regarding its use, reproduction, and disclosure are as set forth in the
Commercial Computer Software-Restricted Rights clause at FAR 52.227-19.

Statement of conditions

In theinterest of improving internal design, operational function, and/or reliability, Nortel Networks Inc. reserves the
right to make changes to the products described in this document without notice.

Nortel Networks Inc. does not assume any liability that may occur due to the use or application of the product(s) or
circuit layout(s) described herein.

Portions of the code in this software product may be Copyright © 1988, Regents of the University of California. All
rights reserved. Redistribution and use in source and binary forms of such portions are permitted, provided that the above
copyright notice and this paragraph are duplicated in all such forms and that any documentation, advertising materials,
and other materials related to such distribution and use acknowledge that such portions of the software were developed
by the University of California, Berkeley. The name of the University may not be used to endorse or promote products
derived from such portions of the software without specific prior written permission.

SUCH PORTIONS OF THE SOFTWARE ARE PROVIDED “ASIS” AND WITHOUT ANY EXPRESS OR IMPLIED
WARRANTIES, INCLUDING, WITHOUT LIMITATION, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.

In addition, the program and information contained herein are licensed only pursuant to alicense agreement that contains
restrictions on use and disclosure (that may incorporate by reference certain limitations and notices imposed by third
parties).

315893-C Rev 00



Nortel Networks Inc. software license agreement

This Software License Agreement (“License Agreement”) is between you, the end-user (“ Customer”) and Nortel
Networks Corporation and its subsidiaries and affiliates (“Nortel Networks’). PLEASE READ THE FOLLOWING
CAREFULLY. YOU MUST ACCEPT THESE LICENSE TERMS IN ORDER TO DOWNLOAD AND/OR USE THE
SOFTWARE. USE OF THE SOFTWARE CONSTITUTES YOUR ACCEPTANCE OF THISLICENSE
AGREEMENT. If you do not accept these terms and conditions, return the Software, unused and in the original shipping
container, within 30 days of purchase to obtain a credit for the full purchase price.

“Software” is owned or licensed by Nortel Networks, its parent or one of its subsidiaries or affiliates, and is copyrighted
and licensed, not sold. Software consists of machine-readable instructions, its components, data, audio-visual content
(such asimages, text, recordings or pictures) and related licensed materiasincluding all whole or partial copies. Nortel
Networks grants you alicense to use the Software only in the country where you acquired the Software. You obtain no
rights other than those granted to you under this License Agreement. You are responsible for the selection of the
Software and for the installation of, use of, and results obtained from the Software.

1. Licensed Use of Software. Nortel Networks grants Customer a nonexclusive license to use a copy of the Software
on only one machine at any one time or to the extent of the activation or authorized usage level, whichever is applicable.
To the extent Software is furnished for use with designated hardware or Customer furnished equipment (“ CFE”),
Customer is granted a nonexclusive license to use Software only on such hardware or CFE, as applicable. Software
contains trade secrets and Customer agrees to treat Software as confidential information using the same care and
discretion Customer uses with its own similar information that it does not wish to disclose, publish or disseminate.
Customer will ensure that anyone who uses the Software does so only in compliance with the terms of this Agreement.
Customer shall not a) use, copy, modify, transfer or distribute the Software except as expressly authorized; b) reverse
assemble, reverse compile, reverse engineer or otherwise trand ate the Software; ¢) create derivative works or
modifications unless expressly authorized; or d) sublicense, rent or lease the Software. Licensors of intellectual property
to Nortel Networks are beneficiaries of this provision. Upon termination or breach of the license by Customer or in the
event designated hardware or CFE isno longer in use, Customer will promptly return the Software to Nortel Networks or
certify its destruction. Nortel Networks may audit by remote polling or other reasonable means to determine Customer’s
Software activation or usage levels. If suppliers of third party software included in Software require Nortel Networks to
include additional or different terms, Customer agreesto abide by such terms provided by Nortel Networks with respect
to such third party software.

2. Warranty. Except as may be otherwise expressly agreed to in writing between Nortel Networks and Customer,
Softwareis provided “AS IS’ without any warranties (conditions) of any kind. NORTEL NETWORKS DISCLAIMS
ALL WARRANTIES (CONDITIONS) FOR THE SOFTWARE, EITHER EXPRESS OR IMPLIED, INCLUDING,
BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE AND ANY WARRANTY OF NON-INFRINGEMENT. Nortel Networks is not obligated to
provide support of any kind for the Software. Some jurisdictions do not allow exclusion of implied warranties, and, in
such event, the above exclusions may not apply.

3. Limitation of Remedies. IN NO EVENT SHALL NORTEL NETWORKSOR ITSAGENTS OR SUPPLIERSBE
LIABLE FOR ANY OF THE FOLLOWING: @) DAMAGESBASED ON ANY THIRD PARTY CLAIM; b) LOSS OF,
OR DAMAGE TO, CUSTOMER’' SRECORDS, FILES OR DATA; OR c) DIRECT, INDIRECT, SPECIAL,
INCIDENTAL, PUNITIVE, OR CONSEQUENTIAL DAMAGES (INCLUDING LOST PROFITS OR SAVINGS),
WHETHER IN CONTRACT, TORT OR OTHERWISE (INCLUDING NEGLIGENCE) ARISING OUT OF YOUR
USE OF THE SOFTWARE, EVEN IF NORTEL NETWORKS, ITSAGENTS OR SUPPLIERS HAVE BEEN
ADVISED OF THEIR POSSIBILITY. The forgoing limitations of remedies also apply to any devel oper and/or supplier
of the Software. Such devel oper and/or supplier is an intended beneficiary of this Section. Some jurisdictions do not
allow these limitations or exclusions and, in such event, they may not apply.

4, General

a  If Customer isthe United States Government, the following paragraph shall apply: All Nortel Networks
Software available under this License Agreement is commercial computer software and commercial computer
software documentation and, in the event Software is licensed for or on behalf of the United States

Using the 10 Gigabit Ethernet Modules: 8681XLR and 8681 XLW
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Preface

The 8681XLR Module and the 8681 X LW Module are part of the Nortel Networks
Passport line of 10GE LAN/WAN communications products. They are 128K
records modules which allow support for large layer 2 and layer 3 configurations.
This guide describes the features, operations, and configuration requirements for
both modules.

For technical specifications and information about how to install your

10GE LAN/WAN modules, see Installing 8600 Switch Modules. Thisdocument is
provided on the hardware documentation CD purchased with your 8000 Series
Chassis, or can be found on the Nortel Networks documentation Web site at
www.nortel networks.com/documentation, search term: Passport 8000 Series.

A complete list of related publications can be found in the release notes that
accompanied your software release.

Before you begin

This guide isintended for network installers and system administrators who are
responsible for installing, configuring, or maintaining networks. This guide
assumes that you have the following background:

* Understanding of the transmission and management protocols used on your
network

»  Experience with windowing systems or graphical user interfaces (GUIS)

Using the 10 Gigabit Ethernet Modules: 8681XLR and 8681XLW
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Text conventions

This guide uses the following text conventions:

angle brackets (< >)

bold Courier text

braces ({})

brackets ([ )

dlipsispoints(. . .)

Indicate that you choose the text to enter based on the
description inside the brackets. Do not type the
brackets when entering the command.

Example: If the command syntax is
ping <ip addressx>, you enter
ping 192.32.10.12

Indicates command names and options and text that
you need to enter.

Example: Use the dinfo command.
Example: Enter show ip {alerts|routes}.

Indicate required elementsin syntax descriptionswhere
thereis more than one option. You must choose only
one of the options. Do not type the braces when
entering the command.

Example: If the command syntax is
show ip {alerts|routes}, you must enter either
show ip alerts Or show ip routes, but not both.

Indicate optional elements in syntax descriptions. Do
not type the brackets when entering the command.

Example: If the command syntax is

show ip interfaces [-alerts], yOu can enter
either show ip interfaces Or

show ip interfaces -alerts.

Indicate that you repeat the last element of the
command as needed.

Example: If the command syntax is
ethernet/2/1 [<parameter> <value>]...,
you enter ethernet/2/1 and as many
parameter-value pairs as needed.
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italic text

plain Courier
text

separator (>)

vertical line ()

Acronyms

Indicates new terms, book titles, and variablesin
command syntax descriptions. Where avariable istwo
or more words, the words are connected by an
underscore.

Example: If the command syntax is
show at <valid routes>, valid route iSoOne
variable and you substitute one value for it.

Indicates command syntax and system output, for
example, prompts and system messages.

Example: set Trap Monitor Filters

Shows menu paths.

Example: Protocols > IP identifies the | P option on the
Protocols menu.

Separates choices for command keywords and
arguments. Enter only one of the choices. Do not type
the vertical line when entering the command.

Example: If the command syntax is
show ip {alerts|routes}, you enter either

show ip alerts Or show ip routes, but not
both.

This guide uses the following acronyms:

BER
GE
MLT
QoS
SONET
STG

Bit Error Rate

Gigabit Ethernet

MultiLink Trunking

Quality of Service
Synchronous Optical Network
Spanning Tree
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Hard-copy technical manuals

You can print selected technical manuals and release notes free, directly from the
Internet. Go to the www.nortel networks.com/documentation URL. Find the
product for which you need documentation. Then locate the specific category and
model or version for your hardware or software product. Use Adobe* Acrobat
Reader* to open the manuals and release notes, search for the sections you need,
and print them on most standard printers. Go to Adobe Systems at the
www.adobe.com URL to download afree copy of the Adobe Acrobat Reader.

A list of related publications for this manual can be found in the release notes that
came with your software.

How to get help

If you purchased a service contract for your Nortel Networks product from a
distributor or authorized reseller, contact the technical support staff for that
distributor or reseller for assistance.

If you purchased a Nortel Networks service program, contact Nortel Networks
Technical Support. To obtain contact information online, go to the

www.nortel networks.com/cgi-bin/comments/comments.cgi URL, then click on
Technical Support.

From the Technical Support page, you can open a Customer Service Request
online or find the telephone number for the nearest Technica Solutions Center.
If you are not connected to the Internet, you can call 1-800-4ANORTEL
(1-800-466-7835) to learn the telephone number for the nearest Technical
Solutions Center.

An Express Routing Code (ERC) is available for many Nortel Networks products
and services. When you use an ERC, your call isrouted to atechnical support
person who specializes in supporting that product or service. To locate an ERC for
your product or service, go to the http://www.nortel networks.com/hel p/contact/
erc/index.html URL.
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Chapter 1
About 10 Gigabit Ethernet LAN/WAN Modules

This chapter describes the conceptual information and the configurable
parameters for the 10 GE LAN/WAN modules, and contains the following topics:

Topic Page
10GE LAN/WAN Modules concepts 17
Default 10GE LAN module configuration 20
Default 10GE WAN module configuration 21

Additional configurable 10GE LAN module parameters 22

Additional configurable 10GE WAN module parameters |24

10GE LAN/WAN Modules concepts

Ten Gigabit Ethernet (10GE) differs from Gigabit Ethernet not only in supporting
an order of magnitude faster media speed, but also in providing both WAN and
LAN connectivity.

Extending Ethernet over metropolitan and wide area networks provides more
cost-effective solutions for larger geographic areas and ensures end-to-end
Ethernet connectivity. WAN Ethernet frames going across a fiber-optic link are
enclosed within SONET/SDH payload. Embedding Ethernet packets inside
SONET frames requires support for SONET-like management, configuration and
statistics.

Unlike the WAN 10GE, the LAN version of 10GE does not use SONET as the
transport mechanism. WAN and LAN mode of operations are not programmable.
Dueto different clock frequencies, LAN and WAN versions of the 10GE module
have different module IDs and part numbers as shown in Table 1.
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18 Chapter 1 About 10 Gigabit Ethernet LAN/WAN Modules

Table 1 10GE LAN/WAN module IDs and part numbers

Minimum
Hardware Product description software |Part number
version
8681XLW module 1-port 10 Gigabit Ethernet 3.3.0 DS1404052
(1310nm WAN serial)
8681XLR module 1-port 10 Gigabit Ethernet 3.3.0 DS1404053
(1310nm LAN serial)

LAN PHY features

Thefollowing 10GE LAN PHY features are availablein release 3.3:

 LAN, MAN, WAN Ethernet pt-pt applications. Incompatible with SONET
TDM/DWDM 0OC-192 optical networks

» PEC DS1404053 for single Port 1310 nm 10GE LAN serial module
e Compliant with IEEE 802.3ae standards

e 802.3 Ethernet frame format, MAC, Layer functionality

» 10.3125 Gbps data rate.

* 64B/66B line encoding

e Asynchronous Ethernet Interface

o 128K records

LAN PHY FEFI

The LAN version of 10 Gigabit Ethernet supports far end fault indication (FEFI).
Remote failure is detected at the MAC level. Upon receiving FEFI notification
from the remote site, the 10GE modul€'s port changesitslink state to
non-operational.
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WAN PHY features

The following displays the 10GE WAN PHY features available in release 3.3:

 LAN, MAN, WAN Ethernet pt-pt applications. Simple, low cost access to
SONET TDM/DWDM OC-192 optical networks.

» PEC DS1404052 for single port 1310 nm 10GE WAN serial module

e Compliant with IEEE 802.3ae standards

*  9.9532 Gbps datarate. Compatible with SONET OC-192/SDH STM-64
payload rate. SONET framer and Ethernet MAC functionality

* 64B/66B line encoding and simplified SONET/SDH framer

» Asynchronous Ethernet Interface

o 128K records

WAN PHY clocking

Although the default mode for each 10GE WAN port is to generate its transmit
clock from itsown internal clock, aloop timing option is provided for applications
involving synchronization to Sonet/SDH equipment and atiming hierarchy. You
need to manually configure the Passport 8000 Switch Series to change the clock
setting from internal to line timing.

When using theinternal clock and directly connected to another 10GE WAN port,
the other side of the link may be set to either internal or line (loop) clocking. If
one side of thelink is set for line clocking, care must be taken to configure the
other side for internal clocking in order to avoid a potentia timing loop.

Unless there is a specific requirement for loop timing in a system, internal timing
isrecommended, since the transmit side will then continue to operate even if there
is afailure on the incoming Receive Side Signal.

For more information about WAN PHY clocking and synchronization
applications, see Network Design Guidelines (Passport 8000 Switch Series
Release 3.3 Implementation Notes) (part number 313197-B).
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WAN PHY FEFI

The WAN PHY version of 10GE WAN modul e supports FEFI. When one end of a
10GE WAN module link detects alink-down condition or is administratively
disabled, it notifies the other end of the link through the use of SONET Alarm
Indication Signal (AlS). Upon receiving this notification, the other end changesits
link state to down.

For an in depth study of 10GE WAN technology in your network, see Network
Design Guidelines (Passport 8000 Switch Series Release 3.3 Implementation
Notes) (part number 313197-B).

Default 10GE LAN module configuration

The 8681X LR (10GE LAN) Module (Figure 1) consists of a printed circuit board
with status LEDs, and one 10GBASE-LR 1310nm 10gigabit Ethernet serial LAN
port. The 10GBASE-LR port (10.3 Gb/sLAN PHY) operatesin full-duplex mode
and provides transmission ranges of up to 10 km using 9/125 pm single-mode
fiber cable.

Figure 1 8681XLR (10GE LAN) Module

IXLR
¢} e}
eSIok
OWETT R o
1

DO

1 =Online LED
2 = 10GBASE LR port
3 = Port RX and TX LEDs 10548EA

Table 2 describes the default 10GE LAN Module configuration.

Table 2 10GE LAN Module default settings

Parameter Default
Debug Disabled
Lock False
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Table 2 10GE LAN Module default settings (continued)

Parameter Default

Oversize frame Disabled
Perform tagging Enabled
Spanning Tree Protocol 802.1D Enabled
Tagged frame discard Disabled
Unknown MAC discard Disabled
Untagged frame discard Disabled

Default 10GE WAN module configuration

The 8681XLW (10GE WAN) Module (Figure 2) consists of aprinted circuit
board with status LEDs, and one 10GBA SE-LW 1310nm 10 gigabit Ethernet
serial WAN port. The 10GBASE-LW port (9.953 Gb/s WAN PHY) operatesin
full-duplex mode and provides transmission ranges of up to 10 km using
9/125 um single-mode fiber cable.

Figure 2 8681XLW (10GE WAN) Module
o X | RX oTx
(i~ ]1

1 = Online LED
2 = 10GBASE LW port
3 =Port RX and TX LEDs

10547EA
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Table 3 describes the default 10GE WAN Module configuration.

Table 3 10GE WAN Module default settings

Parameter Default
Clock source Internal
Debug Disabled
Framing SONET
Lock False
Oversize frame Disabled
Perform tagging Enabled
Spanning Tree Protocol RFC 1638 | Enabled
Tagged frame discard Disabled
Unknown MAC discard Disabled
Untagged frame discard Disabled

Additional configurable 10GE LAN module parameters

Table 4 describes the additional parameters that can be configured for the 10GE
LAN Module.

Table 4 10GE LAN Module configurable parameters

Parameter Option Default setting

config ethernet
lock

<slot/port>

true (enable)
false (disable)

false (disabled)

config ethernet
name

<slot/port>

<name> (1..20 characters)

No name assigned

config ethernet
enable-diffserv

<slot/ports>

true (enable)
false (disable)

false (disabled)

config ethernet
access-diffserv

<slot/ports>

true (enable)
false (disable)

false (disabled)
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Table 4 10GE LAN Module configurable parameters (continued)

Parameter Option Default setting
config ethernet <slot/ports 0 =none 1
gos-level 1 = standard

2 = bronze
For more information about quality of service |3 = silver
(Qos), see “Quality of Service (Q0S)” on _

4 =gold
page 29. )

5 = platinum

6 = premium

7 = net control
config ethernet <slot/ports> enable | disable disabled
unknown-mac-discard
config ethernet <slot/ports> <vlan id>(1..4092) 1
default-vlan-id
config ethernet <slot/ports> enable | disable disabled
tagged-frames-discard
config ethernet <slot/ports> enable | disable enabled
perform-tagging
config ethernet <slot/ports> enable | disable disabled
untagged-frames-discard
config ethernet <slot/ports> enable | disable disabled
loop-detect
config ethernet <slot/ports> enable (up) up
state disable (down)

test
config ethernet <slot/ports> enable | disable enabled
linktrap
config ethernet <slot/ports> enable | disable disabled
rate-limit <multicast |
broadcast>
config ethernet <slot/ports> enable | disable disabled
tx-flow-control
config ethernet <slot/ports> enable | disable enabled

fc-pause0
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Table 4 10GE LAN Module configurable parameters (continued)

cp-limit

Parameter Option Default setting
config ethernet <slot/ports> (1..65535) This parameter is | 65535
fc-pause-time set in slots. One slot equals

512-bit transmission time.

For 10Gb/s, one slot

corresponds to ~51.2

nanoseconds
config ethernet <slot/ports> enable | disable enabled

Additional parameters:
multicast-limit
broadcast-limit

multicast control frame rate
(1000..100000)
broadcast frame rate
(1000..100000)

multicast-limit 15000

broadcast-limit 10000

Additional configurable 10GE WAN module parameters

Table 5 describes the parameters that can be configured for the 10GE WAN

Module.

Table 5 10GE WAN Module configurable parameters

Parameter

Option

Default setting

config ethernet <slot/ports
lock

true (enable)
false (disable)

false (disabled)

config ethernet <slot/ports>
name

<name> (1..20 characters)

No name assigned

config ethernet <slot/ports>
enable-diffserv

true (enable)
false (disable)

false (disabled)

config ethernet <slot/ports>
access-diffserv

true (enable)
false (disable)

false (disabled)
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Table 5 10GE WAN Module configurable parameters (continued)

Parameter Option Default setting
config ethernet <slot/ports> 0 =none 1 (standard)
gos-level 1 = standard

2 = bronze

3 =silver

4 =gold

5 = platinum

6 = premium

7 = net control
config ethernet <slot/ports> enable | disable disabled
unknown-mac-discard
config ethernet <slot/ports> <vlan id>(1..4092) 1
default-vlan-id
config ethernet <slot/ports> enable | disable disabled
tagged-frames-discard
config ethernet <slot/ports> enable | disable enabled
perform-tagging
config ethernet <slot/ports> enable | disable disabled
untagged-frames-discard
config ethernet <slot/ports> enable | disable disabled
loop-detect
config ethernet <slot/ports> enable (up) up
state disable (down)

test
config ethernet <slot/ports> enable | disable enabled
linktrap
config ethernet <slot/ports> enable | disable disabled
rate-limit <multicast |
broadcast>
config ethernet <slot/ports> line | internal internal
clock-source
config ethernet <slot/ports> sonet | sdh sonet
framing
config ethernet <slot/ports> enable | disable disabled

tx-flow-control
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Table 5 10GE WAN Module configurable parameters (continued)

cp-limit

Parameter Option Default setting
config ethernet <slot/ports> enable | disable enabled
fc-pause0
config ethernet <slot/ports (1..65535) This parameter is | 65535
fc-pause-time set in slots. One slot equals

512-bit transmission time.

For 10Gb/s, one slot

corresponds to ~51.2

nanoseconds.
config ethernet <slot/ports> enable | disable enabled

Additional parameters:
multicast-limit
broadcast-limit

multicast control frame rate
(1000..100000)

broadcast frame rate
(1000..100000)

multicast-limit 15000

broadcast-limit 10000
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Chapter 2
Configuration considerations and limitations

This chapter describes configuration limitations and interoperability issues that
you should consider when configuring your 10GE LAN/WAN modules.

This chapter includes the following topics:

Topic Page
Switching fabric recommendations 28
Multimode fiber (MMF) 28
Jumbo packet support 28
Internal MLT 29
Quality of Service (QoS) 29
Flow control 30
Trunk vs access mode 31
Non-supported features 31
LED information 31
Setting the STG priority 32
10GE WAN SONET/SDH overhead bytes 32
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Switching fabric recommendations

The 10GE LAN/WAN modules are 128K records modules which allows support
for large layer 2 and layer 3 configurations. These modules only operate with
8000 Series software release 3.3 and later.

For 128K record support the following configurations are required:

»  For best performance of the 10GE LAN/WAN modules, Nortel Networks
recommends that you install two SF CPU modules. If the chassisincludes a
8690SF module, the mode defaults back to 32K mode.

* All modulesinstalled in the chassis must support 128K records (M modules)
running 3.3 and later software.

*  MMode (128K records mode) must be enabled. If one, or more modules
installed in the chassisis a 32K records module, these modules will be
disabled if the chassisis configured to operate in MMode (128K records
mode). For instructions on enabling MM ode, see Platform and System
Management.

For more information about your hardware and software compatibility, see
Important information about your hardware and supporting software rel ease
compatibility (part number 314937-A).

Multimode fiber (MMF)

There isno support for MMF in WAN or LAN interfaces.

Jumbo packet support

Jumbo packets are larger than the maximum Ethernet frame size specified in the
|EEE 802.3 standard. For untagged frames, the maximum standard size is 1518
bytes. For tagged frames, it increases by 4 bytes to 1522 bytes.
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The default maximum Ethernet frame size supported by the Passport 8000 Switch
Seriesis 1950 bytes. The 10GE LAN/WAN modul e also supports this frame size.
Passport 8000 Switch Series has a box-wide jumbo frame enable feature, where
all of the portsin the system can support 9600 byte frames. With the addition of
thisfeature, the 10GE LAN/WAN modul es support the increased frame size. Note
that if ajumbo frame enters on a 10GE LAN/WAN interface, and is destined to
egress a chassis interface which does not support jJumbo frames, it is gracefully
dropped.

Internal MLT

Every 10GE LAN/WAN module usesone MLT ID of the 32 MLT IDsavailablein
the Passport 8000 Switch Series. The MLT ID is configured automatically when a
10GE LAN/WAN module is detected in the chassis. For more information about
internal MLT and load balancing, see Network Design Guidelines (Passport 8000
Switch Series Release 3.x Implementation Notes).

Quality of Service (QoS)

10GE LAN/WAN modules provide quality of service features, including 802.1p
and DiffServ support. Eight levels of QoS are supported. The highest level is
reserved for control packets, while the remaining three levels, high, medium and
low priority are used for data traffic.

Table 6 provides the default mappings for differentiated services code point
(DSCP) to 10GE Class of Service (CoS).

Table 6 DSCP to 10GigE CoS default mapping

Traffic .
DSCP Service 10Gige
CoS
Class
CS7 (111000), CS6 (110000) Network High
EF (101110), CS5 (101000) Premium High
AF41 (100010), AF42 (100100), AF43 (100110), CS4 (100000) | Platinum Medium
AF31 (011010), AF32 (011100), AF33 (011110), CS3 (011000) | Gold Medium
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Table 6 DSCP to 10GigE CoS default mapping

Traffic .
DSCP Service 10GigE
CoS
Class
AF21 (010010), AF22 (010100), AF23 (010110), CS2 (010000) | Silver Medium
AF11 (001010), AF12 (001100), AF13 (001110), CS1 (001000) | Bronze Low
DE (000000) and all undefined codepoints Standard Low
User-defined codepoints Standby Low

Table 7 provides the default mappings for 802.1p to 10GE CoS.

Table 7 QoS 802.1p to 10GigE CoS default mapping

Ap value |7 6 5 4 3 2 1 0

10 Gige | High High Med Med Med |Low |Low |Low
CoS

You can change CoS default mappings by using the following CLI commands:

e config gos ingressmap ds
e config gos ingressmap 1p

To change Quality of Service (QoS) mappings, you can use a module-level
command to control QoS settings for al modules in the Passport 8000 Switch
Series, including 10GE LAN/WAN modules. In addition, for 10 GigE, this
command a so controls CoS settings for the previously-mentioned QoS registers.

Flow control

The Passport 8000 Switch Series 10GE LAN module interface supports |EEE
802.3x flow control. The 10GE LAN module interface can generate 802.3x flow
control PAUSE frames when it becomes congested. It also responds to 802.3x
PAUSE frames entering on the other side of the link. The 10GE module interface
temporarily halts packet transmission when an 802.3x PAUSE frameis received
from the remote end.
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Trunk vs access mode

By default, the 10GE LAN/WAN module port comes up as atrunk port with
tagging enabled. Thisis opposite behavior to Passport 8000 Switch Series 10/100
and Gige modules where tagging is disabled by default. As aresult, the 10GE
LAN/WAN module port belongs to multiple VLANs and STGs by default. When
you change tagging mode from trunk (port mode) to access, the port’s previous
association of VLANsand STGsis lost.

Nortel Networks recommends that you use the 10GE LAN/WAN module port as
trunk only.

Non-supported features

The following features are not supported by the 10GE LAN/WAN modules.

» External MLT: Nortel Networks recommends that you use alayer 3 protocol
for resiliency, for example, OSPF associated to Equal Cost MultiPath (ECMP)

» APS (Automatic Protection Switching) is a SONET feature, which per IEEE
P802.3ae is not supported for 10 GBASE Ethernet)

e IPX routing

» Egressport mirroring

e Split MultiLink Trunking (SMLT)
* WSM feature set

LED information

The 10GE LAN/WAN module LEDs for TX and RX are in opposite positions of
those on other 8600 modules.

When a 10 GE LAN/WAN module isin a chassis with redundant CPU
configuration, the Switch Utilization LEDs report switch utilization
on the primary CPU only. (Q00259692)
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Setting the STG priority

Nortel Networks recommends that you keep the value of the STG priority for a
port to as low avalue as possible (which should guarantee that this port is active
after the STP calculation). While the default istypically 128, it is recommended
that you use a value equal to or lessthan 10. To set the Priority parameter using
Device manager, select Edit > Port > STG. To set the priority parameter using the
CLI, usethecommand config stg <sid> priority <number>
(Q00259692)

10GE WAN SONET/SDH overhead bytes

The Sonet/SDH overhead bytes. D1-D3, E1, F1, D4-12, and E2, which are unused
and not supported by the 10GE WAN module, are set to values of all onesin the
first STS-1, while they are zerosin al other STS-Ns (where N=2...192).

Note: For more information about these limitations, contact your local
=>| Nortel Networks representative.
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Chapter 3
Configuring and monitoring the 10GE LAN/WAN
modules using Device Manager

Two management tools enable you to configure your 10GE LAN/WAN modules:
Device Manager and the command line interface (CLI). This chapter describes
only those Device Manager tasks specific to the 10GE LAN/WAN module. For
information on other configuration options, refer to your release notes for alist of
related publications for your software release.

Device Manager is an SNM P-based graphical user interface tool designed to
manage single devices. To use Device Manager, you must have network
connectivity to a management station running Device Manager on one of the
supported platforms. For information on all aspects of installing and running
Device Manager, refer to Installing and Using Device Manager.

This chapter includes the following topics:

Topic Page
Configuring the 10GE LAN/WAN module 34
Viewing 10GE LAN/WAN port statistics 47
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Configuring the 10GE LAN/WAN module

This section describes the specific commands used to configure the 10GE
LAN/WAN modules using Device Manager, and includes the following topics:

» “Configuring the WAN clock source,” next

e “Changing the module's administrative status’ on page 34
» “Configuring the port’s administrative status’ on page 36

* “Configuring the WAN framing type” on page 40

» “Configuring flow control” on page 42

* “Performing a 10GE LAN/WAN loopback test” on page 43
* “Viewing the Trap Log” on page 45

Configuring the WAN clock source

You use the CLI to configure the 10GE WAN module clock source. See
“Configuring the clock source” on page 70.

Changing the module’s administrative status

To enable or disable the 10GE LAN/WAN modul€'s administrative status:

®»On the Device View, double-click on the 10GE LAN/WAN module
(Figure 3).

Figure 3 Device View with the 10GE LAN/WAN module selected
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The Card dialog box opens (Figure 4).

Figure 4 Card dialog box
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Table 8 describes the Card dialog box fields.
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Table 8 Card dialog box fields

Field Description

FrontType/BackType Used to indicate module types in the 8000 Series.
Front refers to the 1/0O portion of the module.

FrontDescription/BackDescription Model number of the module (for example,

8681XLW).
FrontAdminStatus Allows you to change the administrative status of
the module, up (enabled) or down (disabled).
FrontOperStatus Indicates the operational status of this module.
FrontHw\Version/BackHw\ersion Hardware version of the 1/0 module.

FrontPartNumber/BackPartNumber | Part number of the module.

FrontDateCode/BackDateCode Manufacturing date code for the module.
FrontDeviations/BackDeviations Deviations.
SmitOnSingleCpSupported Read-only field. Indicates whether the I/O module

supports this feature. The valid options are false
(no) or true (yes).

PCMCIAType Used to indicate the type of PCMCIA card currently
installed in this CPU module, if any.

For non-CPU modules, this variable has no
meaning and will always be set to none.

PCMCIADescr PCMCIA description.

Configuring the port’s administrative status

To change the a port’s administrative status on the 10GE LAN/WAN module:

1 Onthe Device view, double-click on the 10GE LAN/WAN port (Figure 5).

Figure 5 Device view with 10GE LAN/WAN port selected

The Port dialog box opens with the 10GE Interface tab displayed (Figure 6).
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Figure 6 10GE Interface tab—Port dialog box

£ 192.32.99.152 - Port 7/1
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Table 9 describes the 10GE Interface tab fields.

Table 9 10GE Interface tab field descriptions

Field Description

Index Unique value assigned to each interface. The value ranges
between 16 and 255.

Name Displays the name of this port. To assign or change a name to
the port, highlight the field and enter alphanumeric characters.

Descr Displays the port type of this interface and the slot/port number.

Type Displays the media type of this interface.

Mtu The size of the largest packet, in octets, that can be sent/
received on the interface.

PhysAddress MAC address assigned to a particular interface.

VendorDescr Vendor description.

AdminStatus

Sets the port to either of the following states:

. up
¢« down
« testing

When a managed system initializes, all interfaces start with
AdminStatus in the down state. As a result of either
management or configuration action, the AdminStatus is
changed to the up state (or remains in the down state).

OperStatus

Displays the current operational state of the interface:

. up

e down

If AdminStatus is down, then OperStatus should be down.

If AdminStatus is changed to up, then OperStatus should
change to up if the interface is ready to transmit and receive
network traffic. It should remain in the down state if and only if
there is a fault that prevents it from going to the up state.

LastChange

Displays the value of sysUpTime at the time the interface
entered its current operational state. If the current state was
entered prior to the last reinitialization of the local network
management subsystem, the value is zero.

LinkTrap

Indicates whether or not link Up/link Down traps should be
generated for this interface.

OperDuplex

The current operational duplex mode of the port (always full for
the 10GE LAN/WAN module).
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Table 9 10GE Interface tab field descriptions (continued)

Field Description

OperSpeed Displays the current operating speed of the 10GBASE-LR/LW
port.

QosLevel Quality of service level.

DiffServEnable Used to enable differentiated services on this port.

DiffServType Sets the type of differentiated service to none, access or core.

TelephonyAndMultimediaFilterEnable

Enables IP telephony and MultiMedia Filters.

MultiMediaPlaftormAndDevice

Opens a dialog box that allows you to select the platform and
device for multimedia.

Mitld

MultiLink Trunk to which the port is assigned (if any).

Locked

Displays whether or not the port is locked. When locked, the
port configuration cannot be changed. To lock or unlock a port,
select Edit > Security > Port Lock.

UnknownMacDiscard

If rcUnknownMacDiscard is set to True, then a packet with an
unknown source MAC address is dropped on that port, and
other ports then will discard any packets with this MAC address
in the destination field. For example, suppose 11:22:33:44:55:66
is an unknown source MAC. Packets with source MAC
11:22:33:44:55 coming from this port are discarded;
furthermore, packets with destination MAC 11:22:33:44:55:66
coming from other ports are also discarded, unless this address
is later learned on another port or the restriction ages out.

DirectBroadcastEnable

Used to indicate whether this interface should forward direct
broadcast traffic.

Action Sets one of the following port-related actions:

* none

¢ flushMacFdb—flush MAC forwarding table for port

e flushArp—flush ARP table for port

e flushlp—flush IP route table for port

¢ flushAll—flush all tables for port

e triggerRipUpdate—manually update the RIP table
Result Displays result from the last system action.
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Configuring the WAN framing type

To configure the WAN framing type:

1 Onthe Device View, double-click on the 10GE WAN port (Figure 5).
The Port dialog box opens with the 10GE Interface tab displayed (Figure 6).

2 Click the 10GE WIS tab.
The 10GE WIS tab opens (Figure 7).

Note: The 10GE WIS tab is displayed only when configuring the 10GE
=*| WAN module. If you attempt to configure the transport type of the 10GE
LAN module, the error message noSuchInstance will display.
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Figure 7 10GE WIS tab—Port dialog box.
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Table 10 describes the 10GE WIS tab fields.

Table 10 10GE WIS tab fields

Field

Description

Index

Unique value assigned to each interface. The value ranges
between 16 and 255.

Transport (framing)

Select your framing type based on your WAN connection

type:

¢ sonet (SONET - Synchronous Optical Network);
standard format in North America

« sdh (SDH - Synchronous Digital Hierarchy); standard
format used in Europe

MediumType

The current framing (SONET or SDH) operating on this
interface.

MediumTimeElapsed

Number of seconds, including partial seconds, that have
elapsed since the beginning of the current measurement
period. If, for some reason, such as an adjustment in the
system’s time-of-day clock, the current interval exceeds the
maximum value, the agent will return the maximum value.
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Table 10 10GE WIS tab fields

Field Description

MediumValidintervals Number of previous 15-minute intervals for which
performance monitoring data was collected.

MediumLineCoding Line coding for this interface. This is always Non-Return to
Zero (NRZ) for 10GE WAN.

MediumLineType Line type for this interface. Currently, this will be only

LongSingle, indicating long-range, single-mode fiber.

MediumCircuitldentifier Transmission vendor’s circuit identifier, for the purpose of
facilitating troubleshooting. Note that the circuit identifier, if
available, is also represented by ifPhysAddress.

Configuring flow control

Flow control for 10GE LAN/WAN modules can be configured only using the
command line interface. See “ Configuring flow control” on page 70 for
instructions on how to configure flow control.
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Performing a 10GE LAN/WAN loopback test

This section describes the loopback test featuresin Device Manager available for
the 10GE LAN/WAN Module.

You can perform two types of loopback test, internal and external. The internal
loopback test is the defaullt.

Note: All ports must be in test mode to conduct any testing.

To test for loopback:

1 Onthe Device View, double-click on the port (Figure 5 on page 36).
The Port dialog box opens with the Interface tab displayed (Figure 6 on
page 37).

2 Inthe AdminStatus field, click testing.

Click Apply.

4 Click the Test tab.

The Test tab opens (Figure 8).

Figure 8 Port dialog box—Test tab
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Table 11 describes the Test tab fields.

Table 11 Test tab fields

Field Description

Result Result of the test.

Code Code used for test.

PassCount Number of events which passed the test.
FailCount Number of events which failed the test.

5 Click Ext. Loopback to test the external loopback or click Int. Loopback to
test the internal |oopback.

A dialog box displays the test results.

Click Stop to cease testing.

Click Close.

Click the Interface tab.

In the AdminStatus field, click up.
10 Click Apply.

© 00 N O

Note: To run the external loopback test, you need aloopback cable on
=>| that port.

The test statistics are available only when the test has finished, unlike Ethernet
ports where the test statistics can be viewed during testing.
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Viewing the Trap Log

®Click the bell icon on the toolbar.

&

The Trap dialog box opens (Figure 9).

Figure 9 Trap Log dialog box
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Table 12 describes the fidlds in the Trap Log dialog box.

Table 12 Trap Log dialog box fields

Field Description

Node IP address of the device sending SONET trap.
Time Timestamp in the trap.

Type Type of SONET trap: Section/Line/Path alarm.
Description Description of the alarm: LOS, LOF, and so forth.

Table 13 lists the alarms that are specific to the 10GE WAN module. The alarms
arelisted in order of priority.

Table 13 10GE WAN alarms

Name Description

Section alarms

NO DEFECT No SONET/SDH defects are present.

LOS Loss of signal - not enough Rx power or fiber disconnected.

LOF Loss of frame - unable to frame the signal correctly, possibly due
to improper timing setup.

Line Alarms

L-AIS Alarm Indication Signal - sent out when a port is disabled or
indicates another line failure.

L-RDI Remote Defect Indication - the result of a L-AIS or LOS/LOF at
the remote end.

Path Alarms

P-AIS Path Alarm Indication Signal - indicates a propagation upstream
of a downstream L-AIS alarm or another path failure.

P-LOP Path Loss of Pointer - the pointer to the Sonet SPE is not correct;
sometimes due to dirty fiber, or timing slips.

P-RDI Path Remote Defect Indication- the result of a P-AIS alarm at the

remote end.
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Table 13 10GE WAN alarms (continued)

Name Description

P-SLM Path Signal Label Mismatch - path labels do not match, in
particular the C2 label is mismatched. (The C2 label for 10GE
WAN is 0x1A.)

P-UNEQ Path unequipped - the Sonet path may not be fully provisioned to
handle traffic cross-connects.

Viewing 10GE LAN/WAN port statistics

Device Manager allows you to graph and display certain read-only statistics for
the 10GE LAN/WAN.

The values for the 10GE Interface, 10GE Ethernet Errors, 10GE Bridging, 10GE
Spanning Tree, and 10GE Routing tabs are displayed for absolute, cumulative,
average, minimum, maximum, and last values.

Table 14 describes these values.

Table 14 Types of statistics

Field Description

AbsoluteValue | The total count since the last reset of counters. A system reboot resets
all counters.

Cumulative The total count since the statistics tab was first opened. The elapsed

time for the cumulative counter is displayed at the bottom of the
statistics window.

Average The cumulative count divided by the cumulative elapsed time.

Minimum The minimum average for the counter for a given polling interval over
the cumulative elapsed time.

Maximum The maximum average for the counter for a given polling interval over
the cumulative elapsed time.

LastValue The average for the counter over the last polling period.

The values for the Section, Line, FE Line, Path, and FE Path tabs are updated
based on the poll interval.
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The 10GE LAN/WAN M odules provides the following read-only statistics tabs:

e “Viewing 10GE WAN section statistics,” next

e “Viewing 10GE WAN Line statistics” on page 50

*  “Viewing 10GE WAN FE Line statistics’ on page 52

e “Viewing 10GE WAN path statistics” on page 53

e “Viewing 10GE WAN FE path statistics’ on page 55

*  “Viewing 10GE LAN/WAN interface statistics’ on page 56

*  “Viewing 10GE LAN/WAN Ethernet errors statistics’ on page 59
e “Viewing 10GE LAN/WAN bridging statistics” on page 63

*  “Viewing 10GE LAN/WAN Spanning Tree statistics’ on page 64
e “Viewing 10GE LAN/WAN routing statistics’ on page 66

Viewing 10GE WAN section statistics

Note: The 10GE WAN module displays only the 10GE SONET statistics.

-p

To display Section statistics:

1 Onthedevice view, right-click the port.
2 Choose Graph 10GE SONET.

The GraphPort dialog box opens with the Section statistics tab displayed
(Figure 10).
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Figure 10 GraphPort dialog box—Section tab
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Table 15 describes the fields in the Section tab.

Table 15 Section tab fields

Field Description

ESs Errored Second (ES) is a second with one or more Coding Violations
or one or more incoming defects, for example, SEF, LOS, AIS, LOP.

SESs Severely Errored Second (SES) is a second with x or more Coding
Violations (CV), or a second with at least one or more incoming
defects.

The value of x is defined for a given Bit Error Rate (BER) as outlined in
Annex 50A of the IEEE 802.3ae specification?.

SEFSs Severely Errored Framing Second (SEFS) is a second containing one
or more SEF events.

CVs Coding Violations (CV) are Bit Interleaved Parity (BIP) errors that are
detected in the incoming signal. CV counters are incremented for each
BIP error detected.

1 A BER of 106 corresponds to the default Section SES threshold of 8554.
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Viewing 10GE WAN Line statistics
To display Line statistics:

On the device view, right-click the port.
2 Choose Graph Port.

The graphPort dialog box opens with the Section statistics tab displayed
(Figure 10 on page 49).

3 Click the Line tab.
The Line tab opens (Figure 11).

Figure 11 GraphPort dialog box—Line tab
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Table 16 describes the fields in the Line tab.

Table 16 Line tab fields

Field Description

ESs Errored Second (ES) is a second with one or more Coding
Violations or one or more incoming defects, for example,
SEF, LOS, AIS, or LOP.

SESs Severely Errored Second (SES) is a second with x or more
Coding Violations (CV), or a second with at least one or
more incoming defects.

The value of x is defined for a given Bit Error Rate (BER) as
outlined in Annex 50A of the IEEE 802.3ae specification?.

CVs Coding Violations (CV) are Bit Interleaved Parity (BIP)
errors that are detected in the incoming signal. CV
counters are incremented for each BIP error detected.

UASs Number of seconds that the interface is unavailable.

1 A BER of 106 corresponds to the default Line SES threshold of 9835.
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Viewing 10GE WAN FE Line statistics

To display FE Line statistics:

1 Onthedevice view, right-click the port.

2 Choose Graph Port.

The graphPort dialog box opens with the Section statistics tab displayed
(Figure 10 on page 49).

3 Click the FE Line tab.
The FE Line tab opens (Figure 12).

Figure 12 GraphPort dialog box—FE Line tab
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Table 17 describes the fields in the FE Line tab.

Table 17 FE Line tab fields

Field Description

ESs Errored Second (ES) is a second with one or more Coding
Violations or one or more incoming defects, for example,
SEF, LOS, AIS, or LOP.

SESs Severely Errored Second (SES) is a second with x or more
Coding Violations (CV), or a second with at least one or
more incoming defects.

The value of x is defined for a given Bit Error Rate (BER) as
outlined in Annex 50A of the IEEE 802.3ae specification.

CVs Coding Violations (CV) are Bit Interleaved Parity (BIP)
errors that are detected in the incoming signal. CV counters
are incremented for each BIP error detected.

UASs Number of seconds that the interface is unavailable.

Viewing 10GE WAN path statistics

To display path statistics:

1 Onthedevice view, right-click the port.
2 Choose Graph Port.

The graphPort dialog box opens with the Section statistics tab displayed
(Figure 10 on page 49).

3 Click the Path tab.
The Path tab opens (Figure 13).
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Figure 13 GraphPort dialog box — Path tab

£ 192.32.99.152 - Graph Port 4/1 x|

Section | Line| FELine Path | FE Patn |

Current
ESs 2
SESs 2
Ch's 3]
LIASS 1]

al ml @l @l ﬁl ClearCnuntersl Clnsel Help...l

R

Table 18 describes the fields in the Path tab.

Table 18 Path tab fields

Field Description

ESs Errored Second (ES) is a second with one or more Coding
Violations or one or more incoming defects, for example, SEF,
LOS, AIS, or LOP.

SESs Severely Errored Second (SES) is a second with x or more
Coding Violations (CV), or a second with at least one or more
incoming defects.

The value of x is defined for a given Bit Error Rate (BER) as
outlined in Annex 50A of the IEEE 802.3ae specification?.

CVs Coding Violations (CV) are Bit Interleaved Parity (BIP) errors
that are detected in the incoming signal. CV counters are
incremented for each BIP error detected.

UASs Number of seconds that the interface is unavailable.

1 The default Path SES threshold of 2400 corresponds to a situation where 30% of all of the
SPEs being received have parity errors detected via the Path BIP checks.
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Viewing 10GE WAN FE path statistics
To display FE path statistics:

1 Onthedevice view, right-click the port.

2 Choose Graph Port.

The GraphPort dialog box opens with the Section statistics tab displayed
(Figure 10 on page 49).

3 Click the FE Path tab.
The FE Path tab opens (Figure 14).

Figure 14 GraphPort dialog box— FE Path tab

£ 192.32.99.152 - Graph Port 4/1 x|

Section | Line | FE Line| Path  FE Path

Current

ESs
SESs
Chsg
LIASS

Ilu Ol El ﬂl ClearCnuntersl Clnsel Help...l

B
u = 3 Y

Table 19 describes the fields in the FE Path tab.
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Table 19 FE Path tab fields

Field Description

ESs Errored Second (ES) is a second with one or more Coding
Violations or one or more incoming defects, for example,
SEF, LOS, AIS, or LOP.

SESs Severely Errored Second (SES) is a second with x or more
Coding Violations (CV), or a second with at least one or
more incoming defects.

The value of x is defined for a given Bit Error Rate (BER) as
outlined in Annex 50A of the IEEE 802.3ae specification.

CVs Coding Violations (CV) are Bit Interleaved Parity (BIP)
errors that are detected in the incoming signal. CV counters
are incremented for each BIP error detected.

UASs Number of seconds that the interface is unavailable.

Viewing 10GE LAN/WAN interface statistics

To view interface statistics:

1 OntheDevice View, select aport (Figure 5).
2 From the Device Manager menu bar, select Graph > Port.

The GraphPort dialog box opens with the 10GE Interface tab displayed
(Figure 15).
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Figure 15 GraphPort dialog box—10GE Interface tab
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Table 20 describes the fields in the 10GE | nterface tab.

Table 20 10GE Interface tab fields

Field Description

InOctets The total number of octets received on the interface,
including framing characters.

OutOctets The total number of octets transmitted out of the interface,
including framing characters.

InUcastPkts The number of packets delivered by this sublayer to a
higher sublayer that were not addressed to a multicast or
broadcast address at this sublayer.

OutUcastPkts The number of packets that higher-level protocols
requested be transmitted that were not addressed to a
multicast address at this sublayer.This total number
includes those packets discarded or not sent.

InMulticastPkts The number of packets delivered by this sublayer to a
higher sublayer that were addressed to a multicast address
at this sublayer. For a MAC layer protocol, this number
includes both Group and Functional addresses.
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Table 20 10GE Interface tab fields (continued)

Field

Description

OutMulticastPkts

The total number of packets that higher-level protocols
requested be transmitted, and that were addressed to a
multicast address at this sublayer, including those that were
discarded or not sent. For a MAC layer protocol, this
number includes both Group and Functional addresses.

InBroadcastPkts

The number of packets delivered by this sublayer to a
higher sublayer that were addressed to a broadcast
address at this sublayer.

OutBroadcastPkts

The total number of packets that higher-level protocols
requested be transmitted, and that were addressed to a
broadcast address at this sublayer, including those that
were discarded or not sent.

InDiscards

The number of inbound packets that were discarded
because of frames with errors or invalid frames or, in some
cases, to fill up buffer space.

InErrors

Number of inbound packets that contained errors
preventing them from being deliverable to a higher-layer
protocol.

InUnknownProtos

Number of packets received via the interface which were
discarded because of an unknown or unsupported
protocol.

InFlowCtrlPkts

The total number of flow control packets received by this
interface.

OutFlowCtrlPkts

The total number of flow control packets transmitted by this
interface.

NumStateTransition

The number of times the port went in and out of service; the
number of state transitions from up to down.
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Viewing 10GE LAN/WAN Ethernet errors statistics

To view Ethernet errors statistics:

1 Onthe Device View, select aport (Figure 5).

2 From the Device Manager menu bar, select Graph > Port.
The GraphPort dialog box opens with the 10GE Interface tab displayed
(Figure 15).

3 Click the 10GE Ethernet Errors tab.
The 10GE Ethernet Errors tab opens (Figure 16).
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Figure 16 GraphPort dialog box—10GE Ethernet Errors tab
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Table 21 describes the 10GE Ethernet Errors tab fields.
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Table 21 10GE Ethernet Errors tab fields

Field Description

AlignmentErrors A count of frames received on a particular interface that are
not an integral number of octets in length and do not pass
the FCS check. The count represented by an instance of
this object is incremented when the alignmentError status
is returned by the MAC service to the LLC (or other MAC
user). Received frames for which multiple error conditions
obtain are, according to the conventions of IEEE 802.3
Layer Management, counted exclusively according to the
error status presented to the LLC.

FCSErrors A count of frames received on a particular interface that are
an integral number of octets in length but do not pass the
FCS check. The count represented by an instance of this
object is incremented when the frameCheckError status is
returned by the MAC service to the LLC (or other MAC
user). Received frames for which multiple error conditions
obtained are, according to the conventions of IEEE 802.3
Layer Management, counted exclusively according to the
error status presented to the LLC.

InternalMacTransmitErrors | A count of frames for which transmission on a particular
interface fails due to an internal MAC sublayer transmit
error. A frame is only counted by an instance of this
object if it is not counted by the corresponding instance
of either the dot3StatsLateCollisions object, the
dot3StatsExcessiveCollisions object, or the
dot3StatsCarrierSenseErrors object. The precise meaning
of the count represented by an instance of this object is
implementation specific. In particular, an instance of this
object may represent a count of transmission errors on a
particular interface that are not otherwise counted.

InternalMacReceiveErrors | A count of frames for which reception on a particular
interface fails due to an internal MAC sublayer receive
error. A frame is only counted by an instance of this object
if it is not counted by the corresponding instance of

either the dot3StatsFrameTooLongs object, the
dot3StatsAlignmentErrors object, or the
dot3StatsFCSErrors object. The precise meaning of the
count represented by

an instance of this object is implementation specific. In
particular, an instance of this object may represent a count
of receive errors on a particular interface that are not
otherwise counted.
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Table 21 10GE Ethernet Errors tab fields (continued)

Field

Description

CarrierSenseErrors

The number of times that the carrier sense condition was
lost or never asserted when attempting to transmit a frame
on a particular interface. The count represented by an
instance of this object is incremented at most once per
transmission attempt, even if the carrier sense condition
fluctuates during a transmission attempt.

FrameToolongs

A count of frames received on a particular interface that
exceed the maximum permitted frame size. The count
represented by an instance of this object is incremented
when the frameTooLong status is returned by the MAC
service to the LLC (or other MAC user). Received frames
for which multiple error conditions obtained are, according
to the conventions of IEEE 802.3 Layer Management,
counted exclusively according to the error status presented
to the LLC.

SQETestErrors

A count of times that the SQE TEST ERROR message is
generated by the PLS sublayer for a particular interface.
The SQE TEST ERROR message is defined in section
7.2.2.2.4 of ANSI/IEEE 802.3-1985 and its generation
described in section 7.2.4.6 of the same document.

DeferredTransmissions

A count of frames for which the first transmission attempt
on a particular interface is delayed because the medium is
busy. The count represented by an instance of this object
does not include frames involved in collisions.

SingleCollisionFrames

A count of successfully transmitted frames on a

particular interface for which transmission is

inhibited by exactly one collision. A frame that is counted by
an instance of this object is also counted by the
corresponding instance of either the ifOutUcastPkts,
ifOutMulticastPkts, or ifOutBroadcastPkts, objects and is
not counted by the corresponding instance of the
dot3StatsMultipleCollisionFrames object.

MultipleCollisionFrames

A count of successfully transmitted frames on a

particular interface for which transmission is

inhibited by more than one collision. A frame that is
counted by an instance of this object is also counted by the
corresponding instance of either the ifOutUcastPkts,
ifOutMulticastPkts, or ifOutBroadcastPkts, objects and is
not counted by the corresponding instance of the
dot3StatsSingleCollisionFrames object.
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Table 21 10GE Ethernet Errors tab fields (continued)

Field Description

LateCollisions The number of times that a collision is detected on a
particular interface later than 512 bit-times into the
transmission of a packet; 512 corresponds to 51.2
microseconds on a 10 Mb/s system. A (late) collision
included in a count represented by an instance of this object
is also considered as a (generic) collision for purposes of
other collision-related statistics.

ExcessiveCollisions A count of frames for which transmission on a particular
interface fails due to excessive collisions.

FrameTooShorts The total number of frames that are too short that were
encountered on this interface.

LinkFailures The total number of link failures encountered on this
interface.

PacketErrors The total number of packet errors encountered on this
interface.

CarrierErrors The total number of carrier errors encountered on this
interface.

LinklnactiveErrors The total number of link inactive errors encountered on this
interface.

Viewing 10GE LAN/WAN bridging statistics
To view bridging statistics:

On the Device View, select aport (Figure 5).
2 From the Device Manager menu bar, select Graph > Port.
The GraphPort dial og box opens with the 10GE Interface tab displayed
(Figure 15).
3 Click the 10GE Bridging tab.
The 10GE Bridging tab opens (Figure 17).
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Figure 17 GraphPort dialog box—10GE Bridging tab
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Table 22 describes the fields in the 10GE Bridging tab.

Table 22 10GE Bridging tab fields

Field Description

InUnicastFrames The total number of incoming unicast frames bridged.
InMulticastFrames The total number of incoming multicast frames bridged.
InBroadcastFrames The total number of incoming broadcast frames bridged.
InDiscards The total number of frames discarded by the bridging entity.
OutFrames The total number of outgoing frames bridged.

Viewing 10GE LAN/WAN Spanning Tree statistics
To view Spanning Tree statistics:

1 OntheDevice View, select aport (Figure 5).
2 From the Device Manager menu bar, select Graph > Port.

The GraphPort dialog box opens with the 10GE Interface tab displayed
(Figure 15).
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3 Click the 10GE Spanning Tree tab.
The 10GE Spanning Tree tab opens (Figure 18).

Figure 18 GraphPort dialog box—10GE Spanning Tree tab
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Table 23 describes the 10GE Spanning Treetab fields.

Table 23 10GE Spanning Tree tab fields

Field Description

InConfigBpdus The number of Config BPDUs received.

InTcnBpdus The number of Topology Change Notification BPDUs
received.

InBadBpdus The number of unknown or malformed BPDUs received.

OutConfigBpdus The number of Config BPDUs transmitted.

OutTcnBpdus The number of Topology Change Notification BPDUs
transmitted.
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Viewing 10GE LAN/WAN routing statistics

To view routing statitics:

On the Device View, select aport (Figure 5).
2 From the Device Manager menu bar, select Graph > Port.
The GraphPort dialog box opens with the 10GE Interface tab displayed
(Figure 15).
3 Click the 10GE Routing tab.
The 10GE Routing tab opens (Figure 19).

Figure 19 GraphPort dialog box—10GE Routing tab
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Table 24 describes the fields in the 10GE Routing tab.

Table 24 10GE Routing tab fields

Field Description

InUnicastFrames The total number of incoming unicast frames routed.
InMulticastFrames The total number of incoming multicast frames routed.
InDiscards The total number of frames discarded by the routing entity.
OutUnicastFrames The total number of outgoing unicast frames routed.
OutMulticastFrames The total number of outgoing multicast frames routed.
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Chapter 4

Configuring and monitoring the 10GE LAN/WAN

modules using the CLI

Two management tools enable you to configure your 10GE LAN/WAN modules:

Device Manager and the command line interface (CLI). This chapter describes
only those CLI commands specific to the 10GE LAN/WAN module. For

information on other configuration options, refer to your release notes for alist of

related publications for your software release.

This chapter describes how to configure the 10GE LAN/WAN module using the

CLI, and includes the following topics:

Topic Page
Roadmap of 10GE commands 68
Configuring the 10GE LAN/WAN module with the CLI 69
Viewing 10GE WAN port statistics with the CLI 72
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Roadmap of 10GE commands

Thefollowing roadmap lists some of the 10GE commands. Usethislist asaquick
reference or click on any command entry for more information.

Command

config ethernet <ports>
clock-source [<internal|lines]

config ethernet <slot/ports
[<enable | disables]

config ethernet <port> framing
[<sonet | sdh>]

config ethernet <port/slots>
tx-flow-control [enable|disable]

config ethernet <port/slots>
fc-pause0 [enable|disable]

config ethernet <port/slots>
fc-pause-time <1...65535>

test loopback <portss> [<int |
ext>]

show ports stats wis activealarms
[<ports>]

show ports stats wis
sectioncurrent [<portss>]

show ports stats wis
sectioninterval <intervalids>
[<ports>]

show ports stats wis linecurrent
[<ports>]

show ports stats wis lineinterval
<intervalids> [<portss>]

show ports stats wis felinecurrent
[<ports>]

show ports stats wis
felineinterval <intervalids>
[<ports>]

315893-C Rev 00



Chapter 4 Configuring and monitoring the 10GE LAN/WAN modules using the CLI 69

Command

show ports stats wis pathcurrent
[<ports>]

show ports stats wis pathinterval
<intervalids> [<portss>]

show ports stats wis fepathcurrent
[<ports>]

show ports stats wis
fepathinterval <intervalids>
[<ports>]

show ports stats wis sonetmedium
[<port>]

Configuring the 10GE LAN/WAN module with the CLI

This section describes the specific commands used to configure the 10GE
LAN/WAN modules using the command line interface, and includesthe following
topics:

e “Configuring the clock source,” next

e “Configuring the port’s administrative status’ on page 70

e “Configuring the WAN framing type”’ on page 70

e “Configuring flow control” on page 70

e “Performing a 10GE LAN/WAN loopback test” on page 72
» “Displaying active alarms’ on page 72
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Configuring the clock source
To configure the clock source of your 10GE WAN module, use the CLI command:
config ethernet <ports> clock-source [<internal]|line>]
where:

» internal mode uses the onboard oscillator to generate the Tx clock
» line mode uses the recovered Rx clock to generate the Tx clock

The default valueis internal.

Configuring the port’s administrative status

To enable or disable port settings on the 10GE LAN/WAN module, use the CLI
command:

config ethernet <slot/port> [<enable | disables]

Configuring the WAN framing type
To configure the WAN framing type, use the CLI command:
config ethernet <port> framing [<sonet]|sdh>]
where:

» sonet is Synchronous Optical Network; standard format in North America
» sdhis Synchronous Digital Hierarchy; standard format in Europe

The default valueis sonet.

Configuring flow control

This section describes how to enable or disable flow control, how to enable or
disable flow-control pause0, and how to set flow-control pause0 time.
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Enabling or disabling flow control

When tx-flow-control isenabled, the TX port will transmit MAC control
pause frames to indicate congestion on the receive side of the port interface. The
link partner will cease transmission based on the MAC control frame pause-timer
value.

To enable or disable flow control for the 10GE LAN/WAN module, use the CLI
command:

config ethernet <port/slot> tx-flow-control [enable|disable]

The default valueisdisable.

Enabling or disabling flow-control-pause0

When tx-flow-control isenabled and fc-pauseo isenabled, the TX port
will transmit MAC control pause frames with atimer value of 0 to indicate to its
link partner to resume transmission.

To enable or disable flow control pause0 for the 10GE LAN/WAN module, use
the CLI command:

config ethernet <port/slot> fc-pause0 [enable|disable]

The default valueis enable

Setting the flow control pause timer

Setting the flow-control - pause time sets the timer value in the MAC control pause
frameto indicate to the link partner how long to pause transmission. The pause
timeisin 512 bit-times.

Note: Do not set the fc-pause-timeto alow value, such as 1 or 2. These
=>| lower values will not have a useful effect on network congestion.
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To set the flow-control-pause0 time, use the CLI command:
config ethernet <port/slot> fc-pause-time <1...65535>

The default valueis 65535.

Performing a 10GE LAN/WAN loopback test

This section describes the loopback test CLI command available for the 10GIGE
LAN/WAN module.

You can perform two types of loopback test, internal and external. The internal
loopback test is the default.

Note: All ports must be in test mode to conduct any testing.

To test for loopback, use the CLI command:

test loopback <portss> [<int | ext>]

Viewing 10GE WAN port statistics with the CLI

This section describes the CLI commands avail able to view 10GE
WAN active dlarms and port statistics:

Displaying active alarms

To display information about active alarms on specified ports, use the CLI
command:

show ports stats wis activealarms [<ports>]

Figure 20 shows sample output for this command.
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Figure 20 show ports stats wis activealarms command output

//;%ssport—8610:5# show ports stats wis activealarms \\\

PORT

NUM ACTIVE ALARM
4/1 No Defect
7/1 LOS

\\E?ssport—8610:5#

Table 25 describesthe show ports stats wis activealarms [<portss]
parameters.

Table 25 show ports stats wis active alarms field parameters

Field Description

Section alarms

NO DEFECT No SONET/SDH defects are present.

LOS Loss of signal - not enough Rx power or fiber disconnected.

LOF Loss of frame - unable to frame the signal correctly, possibly due
to improper timing setup.

Line Alarms

L-AIS Alarm Indication Signal - sent out when a port is disabled or
indicates another line failure.

L-RDI Remote Defect Indication - the result of a L-AIS or LOS/LOF at
the remote end.

Path Alarms

P-AIS Path Alarm Indication Signal - indicates a propagation upstream
of a downstream L-AIS alarm or another path failure.

P-LOP Path Loss of Pointer - the pointer to the Sonet SPE is not correct;
sometimes due to dirty fiber, or timing slips.

P-RDI Path Remote Indicator - the result of a P-AIS alarm at the remote

end.
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Table 25 show ports stats wis active alarms field parameters (continued)

Field Description

P-SLM Path Signal Label Mismatch - path labels do not match, in
particular the C2 label is mismatched. (The C2 label for 10GE
WAN is 0x1A.)

P-UNEQ Path unequipped - the Sonet path may not be fully provisioned to
handle traffic cross-connects.

Viewing 10GE WAN section statistics

To display current section statistics on specified ports, use the CLI command:
show ports stats wis sectioncurrent [<ports>]

Figure 21 shows sample output for this command.
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Figure 21 show ports stats wis sectioncurrent command output

PORT ERRORED SECONDS SEVERELY ERRORED CODE VIOLATION SEVERELY ERRORED
NUM COUNT (ES) COUNT (SES) COUNT (CV-S8) FRAMES (SEF) STATUS

2/1 32 32 1027288 32 LOF

Table 26 describesthe show ports stats wis sectioncurrent
[<ports>] parameters.

Table 26 show ports stats wis sectioncurrent [<ports>] parameters

Field Description

PORT NUM Slot and port number

ERRORED SECONDS COUNT (ES) Errored Second (ES) is a second with one or
more Coding Violations or one or more
incoming defects, for example, SEF, LOS, AIS,
LOPR.

SEVERELY ERRORED COUNT (SES) | Severely Errored Second (SES) is a second
with x or more Coding Violations (CV), or a
second with at least one or more incoming
defects.

The value of x is defined for a given BIT Error
Rate (BER) as outlined in Annex 50A of the
IEEE 802.3ae specification?.

CODE VIOLATION COUNT (CV-S) Coding Violations (CV) are Bit Interleaved
Parity (BIP) errors that are detected in the
incoming signal. CV counters are incremented
for each BIP error detected.

SEVERELY ERRORED FRAMES (SEF) | Severely Errored Framing Second (SEFs) is a
second containing one or more SEF events

STATUS Status of defects.

1 A BER of 106 corresponds to the default Section SES threshold of 8554.
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Viewing current section statistics at a specified interval

To display current section statistics on specified ports at a specified interval, use
the CLI command:

show ports stats wis sectioninterval <intervalids> [<portss>]
where:

» intervalid istheinterval identifier (the interval rangeis 1 to 96 seconds)

» portsisan optional parameter that allows you to specify stats for a specific
port.

Figure 22 shows sample output for this command.

Figure 22 show ports stats wis sectioninterval <intervalid> command output

PORT ERRORED SECONDS SEVERELY ERRORED CODE VIOLATION SEVERELY ERRORED
NUM COUNT (ES) COUNT (SES) COUNT (CV-S) FRAMES (SEF)
2/1 900 900 28883030 900

INTERVAL ID = 1

\_ /
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Table 27 describesthe show ports stats wis sectioninterval
<intervalids> [<ports>] parameters.

Table 27 show ports stats wis sectioninterval <intervalid> [<ports>] parameters

Field Description

PORT NUM Slot and port number

ERRORED SECONDS COUNT (ES) Errored Second (ES) is a second with one or
more Coding Violations or one or more
incoming defects, for example, SEF, LOS, AlS,
LOPR.

SEVERELY ERRORED COUNT (SES) | Severely Errored Second (SES) is a second
with x or more Coding Violations (CV), or a
second with at least one or more incoming
defects.

The value of x is defined for a given Bit Error
Rate (BER) as outlined in Annex 50A of IEEE
802.3ael.

CODE VIOLATION COUNT (CV) Coding Violations (CV) are Bit Interleaved
Parity (BIP) errors that are detected in the
incoming signal. CV counters are incremented
for each BIP error detected.

UNAVAILABLE SECONDS (UAS) Number of seconds that the interface is
unavailable.
INTERVAL ID Each interval (1..96) represents a 15-minute

time period (sometimes called a bin). 96 bins
represents 24 hours.

1 A BER of 106 corresponds to the default Line SES threshold of 9835.

Viewing 10GE WAN current line statistics

To display current line statistics on specified ports, use the CLI command:
show ports stats wis linecurrent [<portss]

Figure 23 shows sample output for this command.
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Figure 23 show ports stats wis linecurrent command output

WIS Line Current Stats

PORT ERRORED SECONDS SEVERELY ERRORED CODE VIOLATION UNAVAILABLE
NUM COUNT (ES) COUNT (SES) COUNT (CV-L) SECONDS (UAS) STATUS

2/1 0 0 0 115 NoDefect

N /

Table 28 describesthe show ports stats wis linecurrent [<portss]
parameters,

Table 28 show ports stats wis linecurrent [<ports>] parameters

Field Description

PORT NUM Slot and port number

ERRORED SECONDS COUNT (ES) Errored Second (ES) is a second with one or
more Coding Violations or one or more
incoming defects, for example, SEF, LOS, AlS,
LOP.

SEVERELY ERRORED COUNT (SES) | Severely Errored Second (SES) is a second
with x or more Coding Violations (CV), or a
second with at least one or more incoming
defects.

The value of x is defined for a given Bit Error
Rate (BER) as outlined in Annex 50A of the
IEEE 802.3ae specification.

CODE VIOLATION COUNT (CV-L) Coding Violations (CV) are Bit Interleaved
Parity (BIP) errors that are detected in the
incoming signal. CV counters are incremented
for each BIP error detected.

UNAVAILABLE SECONDS (UAS) Number of seconds that the interface is
unavailable.
STATUS Status of defects.
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Viewing 10GE WAN line statistics at a specified interval

To display current line statistics on specified ports at a specified interval, use the
CLI command:

show ports stats wis lineinterval <intervalid> [<portss>]
where:

» intervalid istheinterval identifier (the interval rangeis 1 to 96 seconds)

» portsisan optional parameter that allows you to specify stats for a specific
port.

Figure 24 shows sample output for this command.

Figure 24 show ports stats wis lineinterval <intervalid> command output

PORT ERRORED SECONDS SEVERELY ERRORED CODE VIOLATION UNAVAILABLE
NUM COUNT (ES) COUNT (SES) COUNT (CV-L) SECONDS

(UAS)
2/1 0 0 0 900

INTERVAL ID = 1
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Table 29 describesthe show ports stats wis lineinterval
<intervalids> [<ports>] parameters.

Table 29 show ports stats wis lineinterval <intervalid> [<ports>] parameters

Field

Description

PORT NUM

Slot and port number

ERRORED SECONDS COUNT (ES)

Errored Second (ES) is a second with one or
more Coding Violations or one or more
incoming defects, for example, SEF, LOS, AlS,
LOPR.

SEVERELY ERRORED COUNT (SES)

Severely Errored Second (SES) is a second
with x or more Coding Violations (CV), or a
second with at least one or more incoming
defects.

The value of x is defined for a given Bit Error
Rate (BER) as outlined in Annex 50A of the
IEEE 802.3ae specification.

CODE VIOLATION COUNT (CV-L)

Coding Violations (CV) are Bit Interleaved
Parity (BIP) errors that are detected in the
incoming signal. CV counters are incremented
for each BIP error detected.

UNAVAILABLE SECONDS (UAS)

Number of seconds that the interface is
unavailable.

INTERVAL ID

Each interval (1..96) represents a 15-minute
time period (sometimes called a bin). 96 bins
represents 24 hours.

Viewing 10GE WAN FE line statistics

To display current FE line statistics on specified ports, use the CLI command:

show ports stats wis felinecurrent [<portss>]

Figure 25 shows sample output for this command.
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Figure 25 show ports stats wis felinecurrent command output

WIS Line Current Stats

PORT ERRORED SECONDS SEVERELY ERRORED CODE VIOLATION UNAVAILABLE
NUM COUNT (ES) COUNT (SES) COUNT (CV-L) SECONDS (UAS) STATUS

2/1 0 0 0 115 NoDefect

- /

Table 30 describesthe show ports stats wis felinecurrent
[<ports>] parameters.

Table 30 show ports stats wis felinecurrent [<ports>] parameters

Field Description

PORT NUM Slot and port number

ERRORED SECONDS COUNT (ES) Errored Second (ES) is a second with one or
more Coding Violations or one or more
incoming defects, for example, SEF, LOS, AlS,
LOP.

SEVERELY ERRORED COUNT (SES) | Severely Errored Second (SES) is a second
with x or more Coding Violations (CV), or a
second with at least one or more incoming
defects

The value of x is defined for a given Bit Error
Rate (BER) as outlined in Annex 50A of the
IEEE 802.3ae specification.

CODE VIOLATION COUNT (CV-L) Coding Violations (CV) are Bit Interleaved
Parity (BIP) errors that are detected in the
incoming signal. CV counters are incremented
for each BIP error detected.

UNAVAILABLE SECONDS (UAS) Number of seconds that the interface is
unavailable.
STATUS Status of defects.
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Viewing 10GE WAN FE line statistics at a specified interval

To display current FE line statistics on specified ports at a specified interval, use
the CLI command:

show ports stats wis felineinterval <intervalids> [<portss>]
where:

» intervalid istheinterval identifier (the interval rangeis 1 to 96 seconds)

» portsisan optional parameter that allows you to specify stats for a specific
port.

Figure 26 shows sample output for this command.

Figure 26 show ports stats wis felineinterval <intervalid> command output

WIS Far End Line Interval Stats
PORT ERRORED SECONDS SEVERELY ERRORED CODE VIOLATION UNAVAILABLE
NUM COUNT (ES) COUNT (SES) COUNT (CV-L) SECONDS
(UaSs)
2/1 0 0 0 900

QTERVAL ID = 1
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Table 31 describesthe show ports stats wis felineinterval
<intervalids> [<ports>] parameters.

Table 31 show ports stats wis felineinterval <intervalid> [<ports>] parameters

Field Description

PORT NUM Slot and port number

ERRORED SECONDS COUNT (ES) Errored Second (ES) is a second with one or
more Coding Violations or one or more
incoming defects, for example, SEF, LOS, AlS,
LOPR.

SEVERELY ERRORED COUNT (SES) | Severely Errored Second (SES) is a second
with x or more Coding Violations (CV), or a
second with at least one or more incoming
defects.

The value of x is defined for a given Bit Error
Rate (BER) as outlined in Annex 50A of the
IEEE 802.3ae specification.

CODE VIOLATION COUNT (CV-L) Coding Violations (CV) are Bit Interleaved
Parity (BIP) errors that are detected in the
incoming signal. CV counters are incremented
for each BIP error detected.

UNAVAILABLE SECONDS (UAS) Number of seconds that the interface is
unavailable.
INTERVAL ID Each interval (1..96) represents a 15-minute

time period (sometimes called a bin). 96 bins
represents 24 hours.

Viewing 10GE WAN path statistics

To display current path statistics on specified ports, use the CLI command:
show ports stats wis pathcurrent [<portss]

Figure 27 shows sample output for this command.
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Figure 27 show ports stats wis pathcurrent command output

WIS Path Current Stats

PORT ERRED SECS SEVERELY ERRED CODE VIOLATION UNAVAILABLE
NUM COUNT (ES) COUNT (SES) COUNT (CV-P) SECONDS (UAS) STATUS WIDTH

Table 32 describesthe show ports stats wis pathcurrent [<portss]
parameters,

Table 32 show ports stats wis pathcurrent [<ports>] parameters

Field Description

PORT NUM Slot and port number

ERRORED SECONDS COUNT (ES) Errored Second (ES) is a second with one or
more Coding Violations or one or more
incoming defects, for example, SEF, LOS, AlS,
LOP.

SEVERELY ERRORED COUNT (SES) | Severely Errored Second (SES) is a second
with x or more Coding Violations (CV), or a
second with at least one or more incoming
defects.

The value of x is defined for a given Bit Error
Rate (BER) as outlined in Annex 50A of the
IEEE 802.3ae specification.t

CODE VIOLATION COUNT (CV-P) Coding Violations (CV) are Bit Interleaved
Parity (BIP) errors that are detected in the
incoming signal. CV counters are incremented
for each BIP error detected.

UNAVAILABLE SECONDS (UAS) Number of seconds that the interface is
unavailable.

STATUS Status of defects.

WIDTH Number of defects.

1 The default Path SES threshold of 2400 corresponds to a situation where 30% of all of the SPEs
being received have parity errors detected via the Path BIP checks.
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Viewing 10GE WAN path statistics at a specified interval

To display current path statistics on specified ports at a specified interval, use the
CLI command:

show ports stats wis pathinterval <intervalids> [<portss]
where:

» intervalid istheinterval identifier (the interval rangeis 1 to 96 seconds)

» portsisan optional parameter that allows you to specify stats for a specific
port.

Figure 28 shows sample output for this command.

Figure 28 show ports stats wis pathinterval <intervalid> command output

PORT ERRORED SECONDS SEVERELY ERRORED CODE VIOLATION UNAVAILABLE
NUM COUNT (ES) COUNT (SES) COUNT (CV-P) SECONDS

(UAS)
2/1 0 0 0 900

INTERVAL ID = 1

- /
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Table 33 describesthe show ports stats wis pathinterval
<intervalids> [<ports>] parameters.

Table 33 show ports stats wis pathinterval <intervalid> [<ports>] parameters

Field

Description

PORT NUM

Slot and port number

ERRORED SECONDS COUNT (ES)

Errored Second (ES) is a second with one or
more Coding Violations or one or more
incoming defects, for example, SEF, LOS, AlS,
LOPR.

SEVERELY ERRORED COUNT (SES)

Severely Errored Second (SES) is a second
with x or more Coding Violations (CV), or a
second with at least one or more incoming
defects.

The value of x is defined for a given Bit Error
Rate (BER) as outlined in Annex 50A of the
IEEE 802.3ae specification.

CODE VIOLATION COUNT (CV-P)

Coding Violations (CV) are Bit Interleaved
Parity (BIP) errors that are detected in the
incoming signal. CV counters are incremented
for each BIP error detected.

UNAVAILABLE SECONDS (UAS)

Number of seconds that the interface is
unavailable.

INTERVAL ID

Each interval (1..96) represents a 15-minute
time period (sometimes called a bin). 96 bins
represents 24 hours.

Viewing 10GE WAN FE path statistics

To display current FE path statistics on specified ports, use the CLI command:

show ports stats wis fepathcurrent [<portss>]

Figure 29 shows sample output for this command.
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Figure 29 show ports stats wis fepathcurrent command output

WIS Far End Path Current Stats
PORT ERRORED SECONDS SEVERELY ERRORED CODE VIOLATION UNAVAILABLE
NUM COUNT (ES) COUNT (SES) COUNT (CV-P) SECONDS (UAS)
2/1 0 0 0 116

Table 34 describesthe show ports stats wis fepathcurrent
[<ports>] parameters.

Table 34 show ports stats wis fepathcurrent [<ports>] parameters

Field Description

PORT NUM Slot and port number

ERRORED SECONDS COUNT (ES) Errored Second (ES) is a second with one or
more Coding Violations or one or more
incoming defects, for example, SEF, LOS, AlS,
LOP.

SEVERELY ERRORED COUNT (SES) | Severely Errored Second (SES) is a second
with x or more Coding Violations (CV), or a
second with at least one or more incoming
defects.

The value of x is defined for a given Bit Error
Rate (BER) as outlined in Annex 50A of the
IEEE 802.3ae specification.

CODE VIOLATION COUNT (CV-P) Coding Violations (CV) are Bit Interleaved
Parity (BIP) errors that are detected in the
incoming signal. CV counters are incremented
for each BIP error detected.

UNAVAILABLE SECONDS (UAS) Number of seconds that the interface is
unavailable.
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Viewing 10GE WAN FE path statistics at a specified interval

To display current FE path statistics on specified ports at a specified interval, use
the CLI command:

show ports stats wis fepathinterval <intervalids> [<portss]
where:

» intervalid istheinterval identifier (the interval rangeis 1 to 96 seconds)

» portsisan optional parameter that allows you to specify stats for a specific
port.

Figure 30 shows sample output for this command.

Figure 30 show ports stats wis fepathinterval <intervalid> command output

PORT ERRORED SECONDS SEVERELY ERRORED CODE VIOLATION UNAVAILABLE
NUM COUNT (ES) COUNT (SES) COUNT (CV-P) SECONDS

(UAS)
2/1 0 0 0 900

INTERVAL ID = 1

- /
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Table 35 describesthe show ports stats wis fepathinterval
<intervalids> [<ports>] parameters.

Table 35 show ports stats wis fepathinterval <intervalid> [<ports>] parameters

Field Description

PORT NUM Slot and port number

ERRORED SECONDS COUNT (ES) Errored Second (ES) is a second with one or
more Coding Violations or one or more
incoming defects, for example, SEF, LOS, AlS,
LOPR.

SEVERELY ERRORED COUNT (SES) | Severely Errored Second (SES) is a second
with x or more Coding Violations (CV), or a
second with at least one or more incoming
defects.

The value of x is defined for a given Bit Error
Rate (BER) as outlined in Annex 50A of the
IEEE 802.3ae specification.

CODE VIOLATION COUNT (CV-P) Coding Violations (CV) are Bit Interleaved
Parity (BIP) errors that are detected in the
incoming signal. CV counters are incremented
for each BIP error detected.

UNAVAILABLE SECONDS (UAS) Number of seconds that the interface is
unavailable.
INTERVAL ID Each interval (1..96) represents a 15-minute

time period (sometimes called a bin). 96 bins
represents 24 hours.

Viewing 10GE LAN/WAN SONET medium statistics

To display current SONET medium statistics on a specified port, use the CLI
command:

show ports stats wis sonetmedium [<ports]

Figure 31 shows sample output for this command.
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Figure 31 show ports stats wis sonetmedium command output

/ﬁg;sport—8610:5# show port stats wis sonetmedium

PORT MEDIUM TIME VALID
NUM TYPE ELAPSED INTERVALS
4/1 sonet 175 1

7/1 sonet 69 1

\5iisport—8610:5#

LINE

LINE CIRCUIT
TYPE ID
LongSingle
LongSingle

Table 36 describesthe show ports stats wis sonetmedium [<ports]

parameters.

Table 36 show ports stats wis sonetmedium [<port>] parameters

Field Description
PORT NUM Slot and port number
MEDIUM TYPE The current framing (SONET or SDH)

operating on this interface.

TIME ELAPSED

Number of seconds, including partial seconds,
that have elapsed since the beginning of the
current measurement period. If, for some
reason, such as an adjustment in the system’s
time-of-day clock, the current interval exceeds
the maximum value, the agent will return the
maximum value.

VALID INTERVALS

Number of previous 15-minute intervals for
which performance monitoring data was
collected.

LINE CODING Line coding for this interface. This is always
Non-Return to Zero (NRZ) for 10GE WAN.

LINE TYPE Line type for this interface. Currently, this will be
only LongSingle, indicating long-range,
single-mode fiber.

CIRCUIT ID Transmission vendor’s circuit identifier, for the

purpose of facilitating troubleshooting. Note
that the circuit identifier, if available, is also
represented by ifPhysAddress.
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Appendix A
Technical Specifications

This appendix lists the technical specifications for the 10GE LAN/WAN modules.

8681XLR (10GE LAN) Module

Physical specifications
Height:
Width:
Depth:
Weight:
Electrical specifications

Input power:

Thermal rating:
MTBF rating
Data Rate and encoding
Compatible with OC-192/STM-64

Module Performance
(64 byte packets)

Aggregate throughput

Routing and Switch Forwarding
Rates

Connector type
Port type

Cable specifications

1.5in. (3.8 cm)
15.4in. (39.1 cm)
18.5in. (47.0 cm)
8.0 1b (3.6 kg)

150 W maximum
512 BTU/hr maximum
140,000 hr

64B/66B(IEEE 802.3ae specified)

No

8x1,488,100 pps
8x1,488,100 pps

SC Duplex

10GBASE-LR 1310nm serial PMD
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Type:
Distance:

Optical specifications
Wavelength:
Optical budget:

Transmitter characteristics:

Receiver characteristics:

LED operation
Rx
Tx/RX

9/125 um single mode fiber optic cable
6.2 miles (10 km)

1310 nm
7.4 dB

Minimum optical power: -5 dBm
Maximum optical power: -1 dBm

Minimum receiver sensitivity: -12.4 dBm
Maximum input power: 1 dBm

Amber during link-down
Green during link-up state and activity
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8681XLW (10GE WAN) Module

Physical specifications

Height: 1.5in. (3.8 cm)
Width: 15.4in. (39.1 cm)
Depth: 18.51in. (47.0 cm)
Weight: 8.0 Ib (3.6 kg)

Electrical specifications

Input power: 150 W maximum
Thermal rating: 512 BTU/hr maximum
MTBF rating 140,000 hr
Data Rate and encoding 64b/66b (IEEE 802.3ae specified)

Compatible with OC-192/STM-64 Yes

Module Performance
(64 byte packets)

Aggregate throughput 8x1,488,100 pps
Routing and Switch Forwarding 8x1,488,100 pps
Rates
Connector type SC Duplex
Port type 10GBASE-LW 1310nm serial PMD

Cable specifications

Type: 9/125 um single mode fiber optic cable
Distance: 6.2 miles (10 km)
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Optical specifications

Wavelength:

Optical budget:

Transmitter characteristics:

Receiver characteristics:

LED operation
Rx
Tx/RX

1310 nm*

7.4dB

Minimum output power: -5 dBm
Maximum output power: -1 dBm
Minimum input sensitivity: -12.4 dBm
Maximum input power: 1 dBm

Amber during link-down or Sonet alarm condition
Green during link-up state and activity

Refer to the Network Design Guidelines (Passport 8000 Switch Series Release 3.3
Implementation Notes) 313197-B for information on interworking with SONET/SDH 1550nm WAN

equipment.
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Appendix B
Error messages

This section describes the error messages may be generated with the 10GE LAN/

WAN modules.

Error message

Generated
node or leaf

Cause

Cannot set framing on this port

framing

You have attempted to set framing
for a non-10Gigabit Ethernet module.
(This attribute is valid for 10GE WAN
modules only)

Cannot modify framing when in
LAN mode

framing

You have attempted to set framing on a
10GE module running in LAN mode.

Cannot delete internal M1t Id

delete

You have attempted to delete a 10GE
internal MLT using the CLI command
config/mlt #/.

Feature is not supported

create

You have attempted to create an IPX route
for a 10GE module port using the CLI
command /config/ethernet
<port>/ipx/create. 10GE modules
do not support IPX routing.

VLAN has a 10GE port member
which doesn't support IPX

create

You have attempted to create an IPX route
for a VLAN which has a 10GE module port
member using the CLI command //
config/vlan <id>/ipx/create.

10GE modules do not support IPX routing.

clock-source is only available
on 10GE WAN port

clock-source

You have attempted to configure the

clock-source for a non-10GE WAN module
port using the CLI command //config/
ethernet <port>/clock-source.

Port <port/slot> is not a 10GE
port. Flow Control is only
available on 10GE ports.

tx-flow-control

You have attempted to configure
tx-flow-control for a non-10GE port
using the CLI command //config/
ethernet <ports>/
tx-flow-control.

Using the 10 Gigabit Ethernet Modules: 8681XLR and 8681XLW




96 Appendix B Error messages

port. Flow Control Pause Zero
is only available on 10GE
ports.

Generated
Error message Cause
node or leaf
Port <port/slot> is not a 10GE |fc-pause0 You have attempted to configure fc-pauseO

for a non-10GE port using the CLI
command //config/ethernet
<port>/fc-pause0.

Port <port/slot> is not a 10GE
port. Flow Control is only
available on 10GE ports.

fc-pause-time

You have attempted to configure
fc-pause-time for a non-10GE port
using the CLI command //config/
ethernet <ports>/
fc-pause-time.
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using the command lineinterface 67
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FE Pathtab 55

features
LAN PHY 18
WAN PHY 19

framing, 10 GE WAN default configuration 22

H

hardware 43

L

LAN PHY
features 18
FEFI 18

LastValue statistics 47

lock
10 GE LAN default configuration 20
10 GE WAN default configuration 22

loopback 43
loopback tests 43

M

management 33
Maximum statistics 47
Minimum statistics 47
module IDs 18
multicast packets 57

O

optical specifications
8681XLR module 92,94
8681XLW module 94

oversize frame
10 GE LAN default configuration 21
10 GE WAN default configuration 22

P

parameters, configurable
10 GE LAN module 22
10 GE WAN module 24

part numbers 18
PCMCIA type 36

perform tagging
10 GE LAN default configuration 21
10 GE WAN default configuration 22

poll interval 47
Port Test dialog box 43
product support 16

publications
hard copy 16

S

Section tab 48, 50, 52, 53

show portsinfo stats wis activealarms
command 72

show ports stats wis feline interval command 82
show ports stats wis felinecurrent command 80
show ports stats wis fepathcurrent command 86
show ports stats wis fepathinterval command 88
show ports stats wis linecurrent command 77
show ports stats wis lineinterval command 79
show ports stats wis pathcurrent command 83
show ports stats wis pathinterval command 85
show ports stats wis section current command 74
show ports stats wis sectioninterval command 76
show ports stats wis sonetmedium command 89
SONET loopback tests 43

specifications, technical
8681XLR module 91
8681XLW module 93

statistics 47

displaying 47
graphing 47
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types 47

STP FRC 1638
10 GE LAN default configuration 21
10 GE WAN default configuration 22

support, Nortel Networks 16

T

tagged frame discard
10 GE LAN default configuraton 21
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technical publications 16
technical specifications 91
technical support 16

test mode 43

testing 43

text conventions 14

troubleshooting 43
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U

unknown MAC discard
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10 GE WAN default configuration 22

untagged frame discard

10 GE LAN default configuration 21
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